
 

 

 

SESSION 1 
The TechnoStock Exchange 

In this session, students become stockbrokers buying shares in companies listed 

on the TechnoStock Exchange (TSE). They begin by learning about how the 

stock market functions. Once familiar with this method of earning money, 

students study company profiles to determine those that look to be a good 

investment. They then buy shares in these companies receiving a stock 

certificate as proof of the purchase. Using Microsoft Excel, students create a 

table that contains information about their stocks, the amount purchased, and 

their current market value. This electronic portfolio is updated each session, to 

help students manage their investments. 

Assignment 1: Introduction to Spreadsheets 

Assignment 2: Introduction to Stock Market Terminology 

Assignment 3: Playing the Stock Market 

Assignment 4: Investment Record Trade 1 

Assignment 5: Organize Investment Information using Excel 

 

Session 1 Review Stock Market and Spreadsheet Checkup 

Session 1 Extension Activity Track the Stock Market on the Internet 
 

  

Each TechnoKids project consists of 6 sessions, 
which are divided into separate assignments. An 
assignment is an activity that takes about 20 
minutes to complete. 

For the paperless classroom, each assignment, review, skill 
review, and extension activity in the TechnoKids Student 
Workbooks is also included as a digital file. 

Learn more about TechnoInvestor 

SAMPLE
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Session 1: The TechnoStock Exchange 

Getting Started 

 

Overview 

In this session, students become stockbrokers buying shares in companies listed on the 

TechnoStock Exchange (TSE). They begin by learning about how the stock market functions. Once 

familiar with this method of earning money, students study company profiles to determine those 

that look to be a good investment. They then buy shares in these companies receiving a stock 

certificate as proof of the purchase. Using Microsoft Excel, students create a table that contains 

information about their stocks, the amount purchased, and their current market value. This 

electronic portfolio is updated each session, to help students manage their investments. 

 
 

Materials 

 Microsoft Excel 

 Flashcards (Optional) 

o Microsoft Excel Home Tab  

 Teacher Resource 

o Investment Portfolio sample  

 Handouts 

o Company Profiles  

o TechnoStock Exchange Listings  

 Game Materials 

o Scrap paper 

o Envelopes 

o Calculators 

o Technodollars 

o TechnoStock Certificates 

 Optional Activities 

o Session 1 Review 

 

Teacher Preparation 

 The Investor folder must be available to students. Detailed instructions are included in the 

Preparing to Teach section of this teacher guide. 

 Prepare Company Profiles and TechnoStock Exchange Listings handout. 

 Prepare Technodollars and TechnoStock Certificates. 

 (Optional) Print flashcards. 

For every session, the Teacher Guide 
features:  
 an introduction with a materials list 
 preparation advice 
 teaching strategies 
 lesson plans for each assignment 
 learning objectives for the session 

SAMPLE
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Teaching Strategy 

In this session, students become stockbrokers. Explain the scenario to students: 

 

Employed by the firm, TechnoInvest, you assume the role of a 

stockbroker where your ultimate responsibility is to earn money for 

your clients. You will learn how the stock market functions by 

purchasing shares in companies listed on the TechnoStock 

Exchange (TSE). You will create an investment portfolio to keep 

track of all transactions using Microsoft Excel. 

 

 

Assignment 1 Introduction to Spreadsheets 

 

It is essential that students possess basic spreadsheet skills. In this assignment, students are 

introduced to the spreadsheet program Microsoft Excel. Once students are familiar with the 

terminology have them complete Assignment 1. Before beginning, discuss the following: 

 

What is a spreadsheet program? 

 A spreadsheet program is a computer application that simulates a paper accounting 

worksheet. It displays multiple cells that together make up a grid consisting of rows and 

columns; each cell contains either alphanumeric text or numeric values. 

 

What does a spreadsheet program do? A spreadsheet program lets a person: 

 enter information and easily edit what is written in a cell 

 calculate numbers easily 

 track numbers and trends over time 

 

Spreadsheet terminology: 

 worksheet: A worksheet is a page made up of columns and rows. 

 column: A column is a group of cells stacked vertically, one on top of another in a worksheet. 

 column heading: A column heading is the name of the column. This is a letter. 

 row: A row is a group cells that are placed horizontally, beside each other in a worksheet. 

 row heading: A row heading is the name of the row. This is a number. 

 cell: A cell is a box where information is put. A worksheet has many boxes. 

 cell name: A cell name is the location of the box where a column and row meet. For example 

a box in column A - row 2, would be called cell A2. 

 name box: The name box tells the name of the selected cell. 

 formula bar: The formula bar is an area where you can add or change information in a cell. 

 

  

This section for teachers 
explains each assignment 
and gives helpful tips. 

SAMPLE
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Assignment 2 Introduction to Stock Market Terminology 

 

In this assignment, students are introduced to the stock market and how it operates. They learn 

terms such as stock, broker, stock exchange, and floor broker. 

 stock: a share of a company, represented by a certificate of ownership. 

 broker: an agent who buys and sells stocks, bonds and other securities for customers, in 

return for a fee or commission. 

 stock exchange: a building or place where stocks, bonds and other securities are bought 

and sold. 

 floor broker: an agent who buys and sells stocks at the stock exchange for customers 

and brokerage houses. 

 

 

Assignment 3 Playing the Stock Market 

 

In this assignment, students are introduced to the stock market simulation of this project. Students 

are grouped into investment teams. Consider keeping groups academically balanced by 

assigning at least one member to each group who possesses good reading skills and/or 

discussion abilities.  

 

The group is given money (Technodollars) and profiles of the fictitious companies. As a team, 

they decide how many stocks they wish to buy and from which companies. Then they purchase 

the stocks from the floor broker (teacher). 

 

 

Assignment 4 Investment Record Trade 1 

 

In this assignment, students begin to record their investment portfolio. This is used in the following 

sessions to track the value of their investments as stock prices vary over time. They list the 

companies, number of shares purchased, and cost of share. Then they calculate the total stock 

value and cash available. 

 

 

Assignment 5 Organize Investment Information using Excel 

 

In this assignment, students transfer the data recorded in Assignment 4 to a spreadsheet. They 

create a table and then format it using Table Styles to make it attractive, clear and easy to read.  

 

Introduce the symbol * to the students. This represents the multiplication function in a 

spreadsheet. 

 

You may wish to have students view the Investment Portfolio worksheet as a sample of the 

completed assignment. Have the students open the completed worksheet from the Investor 

folder copied to each workstation.  

 SAMPLE
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Lesson Plan 

Assignment 1 - Introduction to Spreadsheets 

 Open Microsoft Excel.  

 Label the parts of the Microsoft Excel window including the Ribbon, Formula Bar, Groups, 

Title Bar, Name Box, Tabs, Sheet Tabs, Commands, Help, and Scroll Bars. 

 Use the mouse pointer, SHIFT key, and CTRL key to select columns. Note the differences 

between each method. 

 Use the mouse pointer, SHIFT key, and CTRL key to select rows. Note the differences 

between each method. 

 Select a specific cell and note the cell name. 

 Enter text into a cell by either typing it directly into the box or into the formula bar. 

 Resize the width of a column by double clicking in the header and by manually 

dragging. 

 Resize the row height. 

 Use the ENTER key, tab key, name box and arrow keys to move from cell to cell. 

 Select a range of cells using the SHIFT key. 

 Exit Microsoft Excel. 

 

Assignment 2 - Introduction to Stock Market Terminology 

 What is the stock market? 

 What is a stock? 

 Who sells stocks? 

 Why do people want to buy stocks? 

 How do I purchase stocks? 

 

Assignment 3 - Playing the Stock Market 

 Assemble materials. 

 Acquire Technodollars. 

 Read Company Profiles and Stock Exchange Listings. 

 Decide on stocks to purchase and record  purchases on Investment Record Trade 1 

 

Assignment 4 - Investment Record Trade 1 

 Record Trade 1. 

 

  

The Lesson Plan lists the individual 
steps in each assignment. 

SAMPLE
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Assignment 5 - Organize Investment Information using Excel 

 Open Microsoft Excel. 

 Add table headings. 

 Add stock names to table. 

 Add remaining headings. 

 Enter investment data into the table. 

 Format the table. 

 Save the investment portfolio. 

 Exit Microsoft Excel. 

 

 

  

SAMPLE
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Learning Objectives 

Content Knowledge: 

 analyze business data to make educated trade decisions 

 study companies on the TSE to determine which are a good investment 

 purchase shares in companies listed on the TSE 

 understand the purpose of mathematics in the real world 

 

Technical Skills: 

 

Operating Environment 

 create a new folder to save work 

 open and close a program 

 

Applied Technology: 

 organize information using a spreadsheet 

 

Spreadsheet: 

 open, close and save a worksheet 

 enter data into a cell 

 change the width of a column 

 select a particular row or column 

 locate a cell by reference 

 use the mouse to select a cell 

 use the keyboard to add data to a cell 

 use the formula bar to add data to a selected cell 

 use the arrow, tab and enter keys to move between cells 

 format a table to alter its appearance 

 use the keyboard and mouse to select a range of cells 

 identify parts of a worksheet window – title bar, ribbon, tab, group, command, help, 

name box, formula bar, column heading, row heading, active cell, sheet tab 

 

 

 

Learning Objectives are specified for each 
of the six sessions in the project. 
A checklist of all objectives is provided at 
the end of the project in Session 7. SAMPLE
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Assignment 1: Introduction to Spreadsheets 
 

 

Open Microsoft Excel 

 Open Microsoft Excel.  

 Click Blank workbook.  

 

 

Label the Parts of the Microsoft Excel Window 

 

 

1. File Tab (Backstage)  5. Help  9. Group 

2. Tab  6. Name Box  10. Command 

3. Title Bar  7. Cell  11. Sheet Tab 

4. Ribbon  8. Formula Bar  12. Scroll Bars 

In this assignment, you learn the parts of the Microsoft 

Excel window. 

Terms: 
 Ribbon 

 Formula Bar 

 Group 

 Title Bar 

 Name Box 

 Tab 

 Sheet Tab 

 Command 

 File tab 

 Help 

 Scroll Bars 

 Cell 

Students begin with an introduction to 
the Microsoft Excel window. 

SAMPLE
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Parts of the Microsoft Excel Window:  

Title Bar  A bar at the top of the window that shows the name of the document, 

program name, and the control buttons. 

File Tab  Located at the left of the tabs on the ribbon, the File tab opens Backstage 

view. Backstage View houses commands that affect the document as a 

whole, or the application itself. Commands found here include; saving, 

opening and closing a document, as well as creating a new one, also printing, 

and changing Excel options. To return to the document, click the Back button 

or press escape. 

Ribbon A band along the top of the window that holds the quick access toolbar, title 

bar, tabs, commands, window controls, and other tools. 

Name Box A box that shows the name of the active cell. 

Tab A part of the ribbon used to organize commands that do similar types of 

activities. For example, the Insert tab has commands that add objects to the 

worksheet. 

Help A box at the top right corner of the window that gives help with the program. 

Answers are listed when a question is entered into the box.  

Cell  Found on a worksheet, a cell is a rectangular box that is identified by a unique 

letter and number combination. You would type your number or text into this 

box. 

Group A collection of commands on a tab that do similar actions. For example, the 

Alignment group contains commands that change the placement of text in a 

cell, such as Left, Center, or Right. 

Scroll Bars  Bars used to change the part of the worksheet shown in the window. The 

worksheet can be moved up or down using the vertical scroll bar, or to the left 

and right using the horizontal scroll bar. 

Sheet Tab A tab at the bottom corner of the window that changes the active worksheet. 

Formula Bar A bar that lets you insert or edit the contents of a cell.  

Command A button, menu, or box that tells the program to do a task. A command often 

has a picture that shows the action. For example, the Cut command looks like 

a pair of scissors.  

 

 

 

 SAMPLE
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Working with Columns 

Columns are vertical (up and down) groups of cells. The area at the top of each column is 

called a column heading. Column headings are labeled alphabetically. The worksheet only 

shows a few columns, but Microsoft Excel has a total of 16,384 columns. 

 

 

 

 Click on column heading A.  

 Click on column heading C. 

 Click on column heading E. 

1. What happens when you click on the column headings? 

 The individual column is selected when the column heading is clicked.  

 

 Now, click on column heading A, hold down the SHIFT key, and then click the column 

heading D. 

2. What happens when you click on the column headings? 

 Columns A, B, C, and D are all selected.  

 

 Click on column heading A, hold down the CTRL key, and then click the column C and E 

headings. 

3. What happens when you click on the column headings? 

 Columns A, C, and E only are selected.  

 

 

 

 

  

Follow the instructions to learn how to: 

• select columns, rows, and cells 

• enter text 

• move from one cell to another 

column heading 

column 

For the paperless classroom, students can answer 
the questions in their digital workbooks using the 
latest version of Adobe Reader.  
The Teacher Guide includes answers. 

SAMPLE
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Working with Rows 

Rows are horizontal (left to right) groups of cells. The area to the left of each row is called the 

row heading. Row headings are labeled numerically. The worksheet only shows a few rows, but 

there are over a million rows in Microsoft Excel 2010. 

 

 Click on row heading 5.  

 Click on row heading 10. 

 Click on row heading 15. 

4. What happens when you click on the row headings? 

 The individual row is selected when the row heading is clicked.  

 Now, click on row heading 5, hold down the SHIFT key, and then click the row heading 10. 

5. What happens when you click on the row headings? 

 Rows 5, 6, 7, 8, 9, and 10 are all selected.  

 Click on row heading 1, hold down the CTRL key, and then click the row 5 and 10 

headings. 

6. What happens when you click on the row headings? 

 Rows 1, 5, and 10 only are selected.  

 

Working with Cells 

A cell is the location where a row and column meet. Cells can hold words, numbers, or 

mathematical formulas. Each cell has a name called a cell reference. The cell reference is 

shown in the name box. A cell reference is the column and row location. For example, the cell 

reference for the cell that intersects column A and row 1 is A1. 

 

 With the mouse, click in cell A1 to select it. 

  

row row heading 

name box 

selected cell 

Illustrated, step by step instructions 
make learning spreadsheet skills fun 
and easy.   

SAMPLE
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 Move the mouse to column D, then count down 2 rows. Click to select the cell. 

 

7. Look in the name box. What is the cell reference? 

 D3 

 

 

How to Enter Text 

 Select cell A1, type hello. 

 

 

 Click the mouse at the end of the word hello in the Formula bar. 

 Press the SPACEBAR once and then type the word there. 

 

 

Move from Cell to Cell 

 Press the ENTER key to move from cell A1 to cell A2.  

 Press the TAB key to move from cell A2 to cell B2.  

 Use the mouse to move to cell C3. 

 Highlight C3 in the Name box. Type B4, and then press ENTER to select cell B4. 

 

 

8. List the different ways you can move from cell to cell. 

 1) Click the cell directly with the mouse.   2) Use the ENTER key.   3) Use the TAB key.  

 4) Type the cell reference into the name box. 

  

formula bar 

cell 

You can add text by typing in 

the cell or into the formula bar. 

Helpful tips throughout the 
assignment ensure success and 
assist in troubleshooting. 

SAMPLE
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Resize Column Width 

 Place the mouse pointer between the column A and column B headers. 

 Double click the mouse when the mouse pointer changes to a double arrow. 

2  

 

 

9. What happens? 

 The column width automatically resizes to fit the data in the cell. 

  

 

 Place the mouse pointer between the column A and column B headers. 

 Click and drag the mouse to the right when the mouse pointer changes to a double 

arrow.  

 

 

10. What happens? 

 The column width increases to the desired width. 

  

 

 Place the mouse pointer between the column E and column F headers. 

 Click and drag the mouse to the left when the mouse pointer changes to a double 

arrow. 

11. What happens? 

 The column width decreases to the desired width. 

  

 

  

Questions guide student learning.   

SAMPLE
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Resize Row Height 

 Place the mouse pointer between the row 2 and row 3 headers. 

 Click and drag the mouse to downwards when the mouse pointer changes to a double 

arrow. 

 

12. What happens? 

 The row height increases. 

  

 Place the mouse pointer between the row 4 and row 5 headers. 

 Click and drag the mouse upwards when the mouse pointer changes to a double arrow. 

13. What happens? 

 The row height decreases. 

  

 

Use the Tab Key 

 Press the TAB key. 

14. What is the cell reference of the new active cell? 

 B2. 

  

 

Use the Name Box 

 Click the mouse in cell C3. 

 Select the cell reference C3 in the name box. 

 

 Key in B4, and then press ENTER. 

15. What is the cell reference of the new active cell? 

 B4. 

  

SAMPLE
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Use the Arrow Keys 

 Press the UP (↑) ARROW key. 

16. What is the cell reference of the new active cell? 

 B3 

  

 Press the DOWN (↓) ARROW key. 

17. What is the cell reference of the new active cell? 

 B4 

  

 Press the RIGHT (→) ARROW key. 

18. What is the cell reference of the new active cell? 

 C4 

  

 Press the LEFT (←) arrow key. 

19. What is the cell reference of the new active cell? 

 B4 

  

 

Select a Range of Cells 

Any group of cells (two or more) is called a range. The range address is defined by noting the 

first and last cells in the range separated by a colon (:). 

 Click the mouse in cell A1 to select it. 

 Press the SHIFT key and click to select cell D6. 

20. What is the range address of the selected cells? 

 A1:D6. 

  

 

Exit Microsoft Excel 

 Click the File tab and choose Exit. 

 Do not save the changes. 

 

In this activity, students learn 
spreadsheet skills including:  
 enter data into cells  
 select a row or column 
 change the width of a column 
 locate a cell by reference 
 use multiple methods to move 

between cells 
 format a table  

SAMPLE
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Assignment 2: Introduction to Stock Market Terminology 
 

 

 

What is the Stock Market? 

You may have been to the market with your mom or dad to buy fruit, vegetables, or flowers. A 

market is a place where people come to sell or buy goods. Similarly the stock market is place 

where people buy and sell stocks. 

 

What is a Stock? 

A stock represents ownership in a company. It is a type of investment that buys you a portion or 

share of a company. 

 

Who Sells Stocks? 

Occasionally, a company may need to raise money so that their 

business can continue to grow. They may need new equipment, capital 

for an expansion project such as a new production line in their 

manufacturing plant, or funds for new technology development. 

Everything costs money! Employees, manufacturing, transportation, and 

marketing are all expenses. Dividing the ownership of a company is an 

excellent method of raising money.  

 

Think of what you do when you need money. Do you ask a friend to loan you money? A loan 

means you must pay the money back. So if you borrowed money from a friend you would need 

to repay them in the near future. However, it is better to receive money and not have to pay it 

back. Parents are great for simply giving you money. 

 

Companies would also much rather receive money and not repay it. If they took a loan from a 

bank they would have to repay the bank. But, if they decide to share their company, they can 

sell a portion of it in the form of stocks to other people. Money raised from selling ownership 

never has to be paid back! 

 

  

Read the information 

below to learn stock 

market terminology. 

Next, students are introduced to the stock 
market, how it operates, and stock 
market terminology. 

SAMPLE
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Why Do People Want To Buy Stocks? 

Quite simply people buy stocks to make money. It is a form of investment. When a stock is 

purchased, the company uses the money to help their business grow. The growth results in the 

company earning more money, causing the stock price to rise. If an investor sold their stock at a 

higher price than what they purchased it at, they too, would make money. 

 

For example, let's say you bought a stock in Coca Cola for $50. The company has an excellent 

year – they are selling a lot of product, production costs are lower than ever before, and they 

have a firm plan for future growth. The stock is now worth $75. That means that you, the investor, 

without having to do anything just made $25. That may not sound like much but if you owned 

100 stocks in the company you would have earned $2500.  

 

1.  How much money would you have made if you owned 1000 stocks of Coca Cola? 

 $25,000 WOW! That is a lot of money. 

  

 

Is it really that simple? Wouldn't everyone who owned stocks in companies be rich? 
 

No, it is not that simple. Sometimes companies do not perform well, they make poor business 

decisions or the market changes, and instead of making more money they start to lose money. If 

the company loses money what do you think happens to the value of the stock? Yes, that is 

right, it goes down. 
 

Let's reexamine the purchase of that stock in Coca Cola for $50. 

Say that the company had a bad year and had to recall the 

product due to moldy bottles and people getting sick. A 

production plant had a fire and they were unable to make 

enough cola drinks and now sales are falling. The company is 

losing money. Remember, the stock was purchased at $50, but 

now the stock is worth only $25. If you, the investor, were to sell your 

stock, you would have $25 less than what you originally purchased the stock for. When you 

invest in the stock market you can make a lot of money but you can also lose a lot of money. 

 

2.  If you originally purchased 100 stocks at a cost of $5000, how much money would you 

lose if you sold now? 

 $2,500 

  

 

3.  What would you have lost if you owned and sold 1000 stocks? 

 $25,000 

  

 

4.  What would you have lost if you owned and sold 10,000 stocks? 

 $250,000 

  

 

  Introductory activities can be completed in the 
classroom prior to using computers. 

Questions confirm students’ 
understanding of concepts.  

SAMPLE
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How Do I Purchase Stocks? 

Now that you know that buying stocks can make you money, where do you go to purchase a 

stock? As previously mentioned, stocks are sold on the stock market. But the stock market could 

be far away from where you live. There are markets in Toronto (Toronto Stock Exchange), New 

York (New York Stock Exchange), Tokyo (Tokyo Stock Exchange), and London (London Stock 

Exchange). However, you may not be close to any of those locations. No problem! You can go 

and visit, telephone, or trade electronically on the Internet with your broker. 

 

Brokers work in places called brokerage houses. Their job is to buy stocks for you from the stock 

market. After you contact your broker, he or she sends a message to a person who is working at 

the stock market. This person is called a floor broker. 

 

Your broker tells the floor broker what you want to buy. Now the floor broker goes to the part of 

the stock market that is allocated to this particular stock and makes the purchase on your 

behalf. The trade is then reported using a computer. The floor broker then contacts the broker at 

the brokerage house to let him or her know that the transaction is complete. You now have 

bought a stock! 
 

A paper stock certificate is then issued as proof that you have made the purchase. Typically 

your broker keeps a record of the stock you own rather than sending you the actual certificate. 

The process is repeated when you want to sell your stock. 

 

5.  Do you think you would be a good stock broker? Why or why not? 

  

  

  

  

  

  

 

  

A stock market simulation is a 
meaningful way to show students 
the purpose and application of 
mathematics in the real world. SAMPLE
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Assignment 3: Playing the Stock Market 
 

 

 

 

 

 

 

 

 

 

 

 

Materials 

 Technodollars 

 TechnoStock Certificates 

 Company Profiles handout 

 TechnoStock Exchange Listings 

handout 

 Scrap paper 

 Calculators 

 Pencils 

 Envelopes 

 

Setup 

 

1.  Form small groups of 4 or 5 students. 

  

  

 

2.  Obtain 400 Technodollars as listed in the table below. 

 
Quantity  Denomination Total Value 

1 x 100 100 

2 x 50 100 

5 x 20 100 

5 x 10 50 

8 x 5 40 

10 x 1 10 

 

3.  Acquire a calculator, scrap piece of paper and pencil. 

 

4.  The teacher will act as the floor broker responsible for managing the buying and selling 

of stocks on the TechnoStock Exchange (TSE). Therefore, he or she will need the 

remaining Technodollars and the TechnoStock certificates arranged on a table. 

 

How to Play 

5.  Acquire a Company Profiles handout from the teacher. 

 

  

Throughout this project, you participate in a simulation that replicates trading on the stock 

market. You assume the role of a broker working for an investment company called 

TechnoInvest. In small groups you invest 400 Technodollars in companies listed on the 

TechnoStock Exchange (TSE). At the beginning of each session, you read the articles 

printed in Money and Markets, a business magazine that caters to the leading companies 

listed on the TSE. With each issue of Money and Markets various events are published that 

have an impact on these companies. With stock values rising and falling, you must be wise 

investors in order to make money for your clients. If not, you could lose it ALL! 

Students form investment teams 
and prepare to trade stocks. 

The TechnoInvestor Resource folder 
includes everything teachers need 
for a stock market simulation. 

SAMPLE
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6.  Read the information on each company to determine possible investments. 

 

 

About the Company Profile: 

 

7.  Acquire the TechnoStock Exchange Listings handout. This document contains 

information about the amount of money the companies listed are selling for on the TSE. 

 

8.  Use a calculator and scrap paper to plan which stocks to purchase. 

 

9.  Assign a group member to purchase stocks from the floor broker (teacher). 

 

  

This graph shows the value of the 

stock over 1 year (52 week) 

period. Examining the graph tells 

about the value of the stock.  

Is it rising or falling?  

Is it very volatile? Volatile means it 

has sharp increases or decreases 

over a short period of time. 

Is the value constant? Constant 

means it keeps a similar value 

over time. 

This means that over the 

past year the lowest price of 

the stock was 29. 

echnodollars. 

This means that over the 

past year the highest price 

of the stock was 75. 

Technodollars. 

Company profiles describe 
eight fictitious companies, 
written specifically for 
middle school students. 

Stock exchange listings show 
the value of every company. 
Teachers hand out updated 
listings during each of the 
four trading sessions. SAMPLE
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10.  Tell the floor broker the stocks your group would like to buy and then pay the 

appropriate amount of money. 

 

11.  The floor broker issues a stock certificate for each stock purchased. For example; if 3 

stocks are purchased of Pizza King, then 3 separate TechnoStock certificates are 

issued. 

 

12.  Record group purchases. Refer to the Investment Record Trade 1 assignment for this 

session. 

 

 

 

 

 

 

13.  After the market closes for the day, choose an investment group name. Write this 

name along with the names of group members, on the front of an envelope. 

 

 

14.  Place the purchased certificates and any remaining Technodollars inside the envelope 

and give to the teacher to keep until the next trade. 

 

 

  

Total Investment Portfolio Value: 

Add together the numbers in the Total Stock Value column with 

Cash Available to determine the Total Investment Value. 

Cash Available: 

Write how much money in cash remains after purchasing stocks. 

Name of Share:  

Enter the name of the 

company here. 

Number of Shares:  

Enter the number of 

shares purchased. 

Total Stock Value:  

For each company invested, 

multiply the number of 

shares by the cost, and 

place the value here. 

Cost of Share: 

Enter the value when the 

stock was purchased. 

SAMPLE
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Assignment 4: Investment Record Trade 1 
 

Record Trade 1 

Record the trades made by your investment group in the chart below. 

 

Include the following data: 

 date 

 name of the share purchased 

 number of shares bought 

 cost of share 

 total value of stocks owned for each company 

 amount of cash still on hand 

 

Once complete, calculate the investment portfolio value by adding together the total stock 

values to the amount of cash. 

 

Date: 

Name of Share Number of Shares Cost of Share Total Stock Value 

    

    

    

    

    

    

    

Cash Available  

Total Investment Portfolio Value  

 

  

Student investment groups 
track their purchases in 
preparation for entering the 
data into a spreadsheet. 
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Assignment 5: Organize Investment Information using Excel 
 

 

 

 

 

 

 

Open Microsoft Excel 

 Open Microsoft Excel. 

 Click Blank workbook.  

 

Add Table Headings 

 Select cell A1. Type Investment Portfolio. 

 Select cell A3. Type Date.  

 Press the TAB key. Cell B3 is now active. In this cell type today's date. 

 Click to select cell A4. Type Name of Share. 

 Press the TAB key. Cell B4 is now active. Type Number of Shares. 

 Press the TAB key. Cell C4 is now active. Type Cost of Share. 

 Press the TAB key again. Now cell D4 is active. Type Total Stock Value. Press ENTER. 

 

 To enlarge column A place the mouse pointer between column headings A and B.  

 When the mouse pointer changes to a double arrow, double click the mouse button to 

automatically resize the column to the fit the cell contents. 

 Repeat for columns B, C, and D. 

 

Follow the instructions to organize investment information in a table. Make the 

table look great using Format as Table; a set of preset styles or designs to 

format a range of cells.  

Illustrated, step by step 
instructions show students 
how to record their 
investment portfolio data in 
an Excel spreadsheet. 
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Add Stock Names to Table 

 Select cell A5. In this cell type the first company name, Dream Cola. 

 Press ENTER. Cell A6 is now active. Type Pets R Family. 

 Repeat until each company name appears on the worksheet. 

 Press ENTER.  

– Notice how column A is not wide enough to fit the information.  

You need to resize the column. 

 Position the mouse pointer between column heading A and B.  

 Double click the mouse to resize the column to automatically fit the cell contents.  

The worksheet should look similar to this: 

 

 

Add Remaining Headings 

 Select cell C13. Type Cash Available. 

 Press ENTER. Cell C14 is now active. Type Total Investment Portfolio Value. 

 Resize column C to fit the contents. 

 

Enter Investment Data into the Table 

Refer to the Investment Record Trade 1 handout to obtain trade results and financial data.  

 Select cell B5. 

 Type the number of shares purchased for Dream Cola. If no shares were purchased 

record 0 in the cell.  

 Press ENTER and type the number of shares purchased for Pets R Family. 

 Continue in this manner until an amount has been entered for each company. 
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 Refer to the TechnoStock Exchange Listings handout to enter the cost of each share into 

the table in the Cost of Share column. 

 Now enter the total stock value. (Multiply Number of Shares by Cost of Share).  

 If no shares were purchased for a company, then record 0 in the relative Total Stock 

Value cell. 

 In cell D13 type the amount of cash remaining. 

 In cell D14 type the total investment portfolio value, which is 400 Technodollars. 

 

 

Format the Table 

 Select cell A4, hold down the SHIFT key, then select cell D14 to select the table.  

 

 From the Home tab, locate the Styles group and select Format as Table.  

 

 Click to select a style. 

Dollar signs to show 

currency will be added in 

the next session. 
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 The Format As Table box opens displaying the range of selected cells. Click to select the 

My table has headers option and click OK. 

 

 
 

 

 

 

 

 

Save the Investment Portfolio 

 Click the File tab and select Save. 

 Go to the place where you save your work. (Ask your teacher how to do this.) 

 Click the tool that makes a new folder. 

 Name the new folder Investor. 

 Press ENTER. 

 Name the file Investment Portfolio. 

 Click Save. 

 

Exit Microsoft Excel 

 Click the File tab and select Exit. 

 

 

 

Range of selected 

cells; A4 through D14. 

The most important factor in choosing a style is to make the information 

clear and easy to understand.  
 

The colors and styles are there to make the table look great but also to 

help the viewer read the words and numbers on the table easily. 

The table is formatted 
to make it clear and 
easy to read. 
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Session 1 Review: Stock Market and Spreadsheet Checkup 

 

 

 

1. Stocks are items found in the storeroom of a grocery store.  T or F 

 

2. A stock is a type of investment that buys you a portion or share of a 

company. 

 T or F 

 

3. Money raised from selling ownership has to be paid back.  T or F 

 

4. When a stock is purchased, the company uses the money to help their 

business grow. 

 T or F 

 

5. Everyone who owns stocks in companies is rich.  T or F 

 

6. A broker's job is to buy stocks for you from the stock market.  T or F 

 

7. You can trade stocks by telephone, electronically, or speaking directly 

with your broker. 

 T or F 

 

8. Brokers work in places called stock markets.  T or F 

 

9. Whether a company makes or loses money has little or no effect on stock 

value. 

 T or F 

 

10. After you contact your broker, he or she contacts a floor broker.  T or F 

 

/10 

Answer True (T) or False (F) to the following 

questions. 

Review lessons at the end of 
sessions provide activities to check 
and reinforce newly learned skills, 
concepts, and terminology. 

Teacher Guides include answers. SAMPLE
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Match the term to its correct definition. 

 

      

B 11. Column Headings  A The cell that is currently being worked in. 

    

     

Headings that are labeled alphabetically. C 12.  Name Box B 

    

     

Displays the active cell. D 13.  Row Headings C 

    

     

Headings that are labeled numerically. A 14.  Active Cell D 

    

     

Apply preset color schemes to format cells. F 15.  Range E 

    

     

A group of cells. E 16.  Format as Table F 

    

/6 

 

 

TOTAL:  /16 
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Session 1 Extension Activity: Track the Stock Market on the Internet 

 

Find out about different companies that sell stocks. 

 

You will need: 

 Internet Explorer 

 Microsoft Excel 

 

Internet Research: About Stocks 

 

1. Access the site http://finance.yahoo.com/ and use the symbol lookup feature in order 

to find the ticker symbols for the companies listed in the table below. Once you find 

the ticker symbol, fill in the table for each company. 

 

2. In the last row of the table, select a company of your own choosing and complete the 

chart with its information. 

 

 

 

Company Name Ticker Symbol Opening Price Previous Close 52 Week High 52 Week Low 

Apple Inc.      

Air Canada      

McDonald's Corp.      

Sony Corporation      

Microsoft Corporation      

      

 

 

3. Open Microsoft Excel and create a worksheet to track this information. Apply your 

knowledge to format the worksheet.  

 

4. Save the workbook to your student folder as Portfolio2. 

 

 

TIP: If necessary, change the fractions to 

a decimal. For example, 25 ¾ = $25.75. 

Do this in order to determine how much 

money you will be spending when the 

main portfolio is created.  

Extension Activities at the end of 
sessions provide optional enrichment 
challenges. 
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Questions about the Stock Market 

 

1.  What did you learn about how stocks change in price over time? 

  

  

 

2.  What problems, if any, did you encounter when trying to find the ticker symbol? 

  

  

 

3.  Which stock changed the most since the opening of the day's market? 
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